Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

lad Al 4y

2012 2S5 ) 380 a5 i ) sal

Easy Learning & Easy Used

Al 4y (ST (50 pan U i Cilaps 53 L Jlas 4S sl o) 1080 a0 o) 8 ab Sl i
(Fidle by Jnia)
(2012 Ol sal IS e an aus)rad aa) 58 Ziny (WIS 048 e guia s
) s 5 ame A gl ) b (Sl ]
Slialos sl 438 ) (51 0 G0 clad € OO s 3 (K3 K Ly (lidl-2
siriia Gladad ars i L LEL3
S5l 50 A 38 5 Fas)an A a6l e e S slaid jig
(s 4 e gamge (il g 5 s (s2m 4 sla ) 3l b (LS5
SIS Anbia )23 ga ga samy 50 Sile gainga ) o2l b (sam 4 Jae Al b L6
S5 50 Ja e Gl s 5 e Giale 5 Jb e Jel b LG1LT
il o iy laglaii g (58 R 52 Cpinas 5 g8 laplati 5 550 L (1318

S50 A 5 et Sagl U 19

Page 1 of 167




Edited by Foxit PDF Editor

For Evaluation Only.
[SENAERE

2012 S5l i) sal

s oo AT 180 0 3 Gl (s )\S dndia b i)

s y Help
Mesh  Render Parametric Insert Annotate View  Manage Output Plug-ins  Online  Express Tools  Vault chBook Designer

Solid

D @ r{J @@@5‘5- D@ 7|%] B4 (B C@ - 18 1 |2 1@) 20 Wirefrome  ~

Surface

. . NGEE 5. (2 =
B Brrude 8 mont (02| @ |22 9 MO8 @ O R section | L7 [12] [l [ LA [12 |18 Unsaved View Culling| NoFiter MoveGizmo | Layers | Groups
y i object (B @ @ 00 - | O 2| @ |-|| & A B] & B8] Pane |12~ [@Word @ - . .
Modeling » | Mesh x| SoldEditing | Draw ~ | Modify ~ |Section ~ 5| Coordinates s View ~ | Selection [ —
EELCIEEETIELELREEIREEE \{ﬂ@q@%|ﬁ&§ﬁﬁ\ml&l Standard ~| | 150-25 ~ | B | standard ~| /2| standard -
= oo MEN:=E-| EEED x| Bilyer | Bilaer = || BiCoor Lo S E S & T RS A

[=11Top] [2D Wireframe]

EEEEEEERE TR
e G4 +EECSEEMRE S n

=
B
&
A

“No canvas exists. Please click New Canvas.
Specify opposite corner or [Fence/WPolygon/CPolygon]:

Command :

[ e Y = W i Y R NS S ERER VR ol Y i ]

s e 0dEind Cile g ga a3 (5)p s 5 050 .« Draw toolbarcy! -1

Il /o000 reoan - BEBEA%E

Page 2 of 167

Copyright {c) by Foxit Corporation, 2003 - 2010




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010

For Evaluation Only.
Ol | 258 e 02l 02 s i Cile gua ge (il 15 )0 5 2L o« Modify toolbar ¢ -2
e sa 00 Draw toolbar sta ) nl ) salia) b Ji 5 als Lads i cpl &) giaa ) oaldinl (o)

Al 488 ) ps s p 1) o sm e U adlied S i)
¢S @B ORL+ -~ 10 af

oo o) 228 aan i Cile pin e (55 SIX o3 g) p 5 28k stoolbar Dimension i -3

B

_J}.w

-~ 7

©@0A

1 b U L BB @ FA A | A [ 1502 M

O esd Jbn oyl ) G aS 2l S8 (Command line Yol g ba g8l )8 a5 oy 2 4
sai al (sl abiny 38 Jlio ¢ mdl al gl (oS cand S A oo el ds I8 a5 IS

Jﬁ)l-*ﬂ J.%Ua S @M \J u‘ Ctrl+9 J\ saldiul L .J:\J\}S (AR EOYRY \) k_iLu.uﬂ .l:u\}j R

*|Command:
Command: _measure
Select object to measure: *Cancel*

Command: |

slai 1 4S (g i 5 sam s Clla 5048 Adl e o Cliaidae )3l a5 () age Caand G -5

J\ﬁueﬁetgu“\)‘).luﬁzthij?Jﬁuab&um\JX-Yk_ibaj;aﬁ.\sgnvﬁ.u)jTop
Sl oad iy a0 50 o Glaidg alad () 4S i€ Aa 8 all el ealdia QB Top slad Jl 2l

8L e L3 050 Cmsa ja alad () 050

A

L

Page 3 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

Lalas il 55 oo G SIS ) aaldind by 4SS A8L e age i D131 a3 b 3 Guse ) edldid o 52006
o) 038 AT ) 3 (5l 4o sama 515 )L 5 i) IS ol ) (SIS ) ealiid Ly 5 20 iy a1
4S8 8L e ) gl 4n J ) Gl S ol o gliie JSG A 4 2031 55 (e i e ge Sl ) 5 S
Zoom oK 5 iy aal a1y Zoom Out b Zoom ine e 5 sla Cuaw 4y Ll (ails a

R (oe Z00M 4k lar¢ 2l laS 8 (s 50 (slad S 4S S s (0 S

¢ e Sle (I AR 0l L leer 5 ) 488 Galy 1) pese Slle R) a2l e Pan a0 il
Cliaiie a5z 4 Pan des 48 4i€ da 5.8 S 2l 63 &y sea Pan dee ¢ 23S gl | s 5

LSGABJB\JLSJ\SWMJJAJGAJM\JQLG}A}A

|y Zoom Extents dee S S an s iy Jligd e g0 Sle (555 K148 Sl Gl a g g

Dd e 0dld (bl cdadia 3 a0 S avw S ) AS (5 s HA Sy (Db awl A

ASJJJS@AAJNA\SCL”cHJ\oJ\Aﬁu\hﬁjﬁ\JJ\Jw}AJ\cJUh\a}MAy\}JGAML%)A

S o i YU Ay R s et 0 L
Pl O glita S5 92 40 48 23L 0 AT 5 a0 b Selection Box ¢ L) 8 a5 ol )i_me@_,m_“&_a

D% S Lala s Crand | (g s 0358 SIS Cad ) Crane 5l Laki 4S 6l e 3L 85 Jg) cilla

sl e 0ld Gkt (K0 Jaw e py il oyl

| 7 |
UE‘
- |
oW
| .25 25 30
oy
—3,30 L } 3 ,90—Jf I
X !
| 4
'y | ] =
5
] 2
; g
) L
O H
[T '
4] I I ]
: [
i \(j & ]

e & i TN
_____ | Specify opposite corner or @‘ 217.88 i :L
Page 4 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

Rl (e AT o 50 SIS ) amy ABL Gl 500ty (ol L AS o sase p Glla gl 0

J...\JS\AJIA&_IM\J&LAMM\Ju.nj.ojoJ)S«_ﬁéE&T\?&"_\.AuJJM&MM@&AJF&\M?}JJB

sl e s (K ol ea s ) 3

T Ay \
3 L _
T bast ]
o | T
E (=
. g | I
. |
| B
| :
Specify
=) R E 20
1, 50H F; =3 | | UED_I’ Tvi?
—— [

aidla 8K ol e ) ) 0 DS AS 2 0l e AT Sle guiage L ¢ a g0 adals 0 SIS

S ol i) 53 (e ol ol ) 5 & SLE Gl 148 (Hlala )30 ey Gl )l

O bl aal g L) S) ailiulia e anlail ) )0 g& an 5 3a) 5 4S ol yign av 3 gl n g g8 ) 8
Oinad 5 800 sl ) 381 a yi s Jild JUE) () Waey 5 2080 e alad] ) an i aiil L s 4S8l
Ay oA ey bl IS b iy Gl (pala

P (6 g m ) sy J) W58 (e 5o e Ay (can i s g aalat (6]

Sibe s sl 15T ke ead jalaaliy )3 5 a5l sl 5ea S S| Startup <obe

Wl

Enter new value for STARTUP <1>: I ﬂ

G ) Metric o 02 525 ollad n)eai U aiS | jal o jlisa s ain )y aS )l 58l a5 o 58

oH

Page 5 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

A ed ar i (slimd 3 )5 U i€ SIS OK s 5 5 S

ﬁStartup | 28 |

= D |D

Default Settings

& Start from Scratch

Imperial feet and inches)

Tip
Uses the default metric settings.

G Ledian 1) (cams il 5 53 5200 e Shoady ) S DL 1) S5 g e dayan ol )
S

e ot (o) e adl e e e aSh G e jgia (gl ek G e Ladiaal g sl o
Aed b phepanBan nl) bl g S i) JWUN Gjbe yia 4

tooai Ol 08 Shis) e R i)

Button

¥ Menu: Format > Units

E Command entry: un

Page 6 of 167




Edited by Foxit PDF Editor

Length
Type:

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

Angle
Type:

[Dedmal

[ Decimal Degrees

Precision:

Precision:

l0.00

o

Insertion scale

IUnits to scale inserted content:

[ Clockwise

Millimeters

N

Sample Output

1520
345.0

Lighting

|Units far specifying the intensity of lighting:

[ Irtemational

*)

| ok || cancel ||

Lai) (saals oa iy Al (e XSl )3 sl g aalaii Al 5 00l e age b o ey (pf (B alaT

alali ) m pan )y ol Jlie) Jaey e By 5 sk e i aal 5 g8 Caed ol 2 :Length

D3l ol ble s S saldiul (liel) Decimal 2y ) Wais Chand ol Gl 3 Type

s K sl R ...\:335#\‘)‘)@9\j\w#&&&y\ﬂ@w&\w‘)d:PreCiSion

w‘;\y&gujtstg\ﬁ)ﬁ\}_\psﬁkﬂch\Jq}mujagjjaysoawu\gz\p@@uﬁsu

Page 7 of 167

352 o i 385 0 L 3 Lad s 2L ki

JRTE

2201 DS 5w O )

A el e ) ey jiiald jlea (g5 2 oaldial aal &




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

Length

Type:

| Decimal - |
Precision:

[0 5

CM e Ol ] Glags 5 G328 5 j jlie] H) amy jhia
1S il ol 65 e 1) e ) am jhia G g4l 5 () aal 5 anaii 4 Ja s e Caand () 1 Anglle
S aalaii (5 _bsie) Ul 5) Decimal degrees s s <l cpl 53 Type

A aadaii )y lie) e jhia Gy w9 e Cuend ) Sl 3 :Precision

Angle

Type:

| Decimal Degrees - |
Precision:

[0 7]

e 28 A a5 (5l 1) a5 8 53 Crand () (2938 Gl 50 SIS L Insertion Scale

Insertion scale
|Units to scale inserted content:

|§|"-'1&ters i |

S aalat international s s <wewd (il 53 Lighting

S s 5515 35 e gam g anly Ja L 2015 e (5 58 llagla ol ) 2y

Page 8 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010

For Evaluation Only.

P Slagas 53 03 S 0 A0

90 LS 4idy via ja e alhli b 0o ad 1) o e Slel | e i a8 ) 8 Gl iy

iley AL o2 Jada Lad Cilagus yi 2 el s Ll 58 45 S B 2iS SIS ()

H

Button

£ Toolbar: Standard

&€ Menu: File = Save

S Ot B (0 ()3 a3 S 50 580 pene 3 AS 358 a3 (sl 0y siad (AT ) amy

Savein: ’ . design 33-book city

VI @@xﬂi Views « Tools

e Name
o m-book1
m-book 2
m-book 3
m-book 4
m-book 5
m-book 6
perspective 1
perspective 2
perspective 3
perspective 4
perspective 5
perspective 6
perspective 7

File name:

- - Preview
Date modified

7/23/2010 5:30 PP
7/10/2010 9:42 Al
7/10/2010 9:45 Al
7/10/2010 9:45 Al
7/10/2010 9:45 Al
10/27/2010 6:50 F
7/10/2010 9:45 Al
7/10/2010 9:44 Al
7/10/2010 9:44 Al
7/10/2010 9:44 Al
7/10/2010 9:44 Al
7/10/2010 9:44 Al
7/10/2010 9:43 Al

mn

[ Update sheet and view thumbnails now
m-book B

Files of type: [AutoCJ\D 2004/L.T2004 Drawing (*.dwg)

b 1 O 050 sl g 00 S o pad Al (S e saliil oS 63 YU sla (55 ) RI: age 435G

s b O Al (el Gy 05 S5 AS Glals 3 U S Gl

Page 9 of 167

"




Edited by Foxit PDF Editor
I Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

'\vw-V"rm"'P"""’ e T S _,‘J\"-.W/‘-""'-.JV' P P il i e _,_.d""r"__..f-"-.J'-vc"“rﬂff’

I b

[ Update sheet and view thumbnails now

Files of type: | AutoCAD 2004/L T2004 Drawing (".dwg) - Cancel

S 1 O 555 5 S5 o gl 538 oy (K 3 31 i 4SS ¢ e 4555
4\5&)}24.3&.}5)\53);}@4\3\)u\5u\\u4\ Opt|0no)uj\cdum\blg4\)ﬁwwcmﬁuﬁaﬁ

O 255 e S i) Sal ) A8l () asdie A B3 5e 0505 b S e i pBa

TS s ym p ) )

Al 5L Option s U an il syl g€ culi ] (Option) Opcole aw i 4adia 5

Current profile: <zUnnamed Profiles> F&y Cument drawing: Drawing 1.dwg
| Files | Display |Open and Save | Plot and Publish IS‘,'stem | User Preferences I Dirafting | 30 Madeling I Selection | Profilesl

Window Elements Display resolution

Color scheme: [Dark v] f& 1000 Arc and circle smoothness

[ Display scroll bars in drawing window ] Segments in a polyline curve

[ Display Drawing status bar £ 05 Rendered object smoothness
[] Use large buttens for Toolbars
Resize ribbon icons to standard sizes
Show ToolTips Display perfformance

Show shorteut keys in Tool Tips . ] Pan and zoom with raster & OLE

Show extended ToalTips fi Highlight raster image frame only

7 MNumber of seconds to delay f Apply solid fil
Show rollaver ToolTips ‘% [ Show text boundary frame onty
[] Draw true silhousttes for solids and surfaces

4 Contour lines per surface

[ Calors... ] [ Fonts...

Crosshair size

3

Layout elements D

Digplay Layout and Model tabs Fade control

Display printable area ¥ref display

Display paper background 70 D
Display paper shadow Inplace edit and annotative representations

[C] Show Page Setup Manager for new layouts 50
Create viewpaort in new layouts

5w 3h 1 o938 Cuad Save As (ERs )2 s sOpen and Save < s 2l s S

Al DWG e b Laia 48 203l 43800 da 55 408 Qamih ) 55 0l 0505 S
Page 10 of 167




Edited by Foxit PDF Editor

For Evaluation Only.

R Jlee ) aadaii () B aiS SQIS Ok s L) 0

Currert profile: <<lUnnamed Profile>> 5 Curmrent drawing: Drawing1.dwg
Files | Displa;,l Open and Save IF‘Iut and Publish | System I User Preferences I Drafting | 30 Modeling |Seledion | F‘mﬁlesl
File Save File Open
Save as: cl Mumber of recently-used files
L[émCﬁD 2000/ T2000 Drawing (*.dwg) '] [ Display full path in title
MMaintain visual fidelty for annotative objects (1 Application Menu
Maintain drawing size compatibility @ 3 Number of recertly-used fles
’ Thumbnail Preview Settings...
50 Incremertal save percentage Extemal References (¥refs)
Demand load Xrefs:

File Safety Precautions [En bled with
abled with copy

- -
r\ucjifﬁuu-n- J‘“.’k - "“"J""r.w; P o

R0 oo DS lite 5Ll ) 53 ol sala (sl o jlail jadashad a5 6l t (B3) LINEn/

-5 ol Al sl cilla

/

Button

% Ribbon: Home tab » Draw panel » Line

% Menu: Draw » Line

% Toolbar: Draw

4 a5 (e JSE (3L 25 (e i il 4 s 9 el S ¢y std ) ) ) Gyt a0 s
oS as il (i ) 4

Page 11 of 167

Copyright {c) by Foxit Corporation, 2003 - 2010

"




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

503 S an ju iy ) dall anil 8 e siwd sl ya) 3l am a8 &) gea b an s o) ) aas i -]

AES s iy sl 5 9 BB 0 il (s 1) dashaa

'

41 s slad S ¢ Jgh adaits QA 5 ) sl (gl gal ) (g 4S Oy g Gl 4oz 0 S0 L s 1D

S e i L) 0 gea Sl ) Hhaia s dae geala S a HhaT S ) se G

Al by 5 a0 30 15 F8 a5 anu yi (63 5ee L 88 s 3 DalS e ok 48 agial & 8 2 e 43S
S

Aed oo Jd e 5 Jlad QAL ja b 2 SGIS Ortho Mode s

/
EElE M Ela

P

o R R

Sl ) @jbe Jl kel ATl ) sien ) a) Sl Gw @) se il bilad s i3

SHIFT@ N SHIFT<6
b1y e dsk =N

44 )=0

A0 il 2S5 ead (el Cumdsa a1y anl ) s Jsh

Page 12 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

Specty nest pointor 9] @ |50 5]

8L Jd e FB AS ol g s s ) )3 1 e 4555
sl Tal ) w58 oo o) ) gida Lk 51 SHIFT@ N SHIFT<0) ealéind 81 g 4354

il Jed Dynamic Input 4 R 455l a4y (oS

o ecify next point or

RIRIANAE Model

" Command: 1

LINE Specify first point:
Specify next point or [Undo]: \—|

B IR

i€ S g g ph adads o) gie 4 ) adall o cLine ) QRS ) ax aS 2l e G sa S i
45l 558 J8 Jsh U s oS 50 1) Tab )b o 528 315008 Slealdinl L)) ki a0 sk o 58

A Al el 5y 5 a3l 1) Hhaiaysednsly da 5258 Jlad

Page 13 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

Al ot QAT () s b e 5 ) a5 s gaa Gl ol a1 o lailiad s .‘
\wJﬁu&ﬁwﬂ&\ﬁ%uﬁﬁ%\e‘\sﬁ\e‘sﬂ.—ﬂiﬁ‘wﬂj‘}“—i—ﬂaﬂbw‘JJ:.
S A8

el QAT ) (G b Lise adalli S5 2l 4S 2L o A 0l 5 )l 0l

o5 AT siand 4nldl (51 ¢ S AT | g umge din b S ab cilla ol o [l

D9 e Ao aan 53 ) WS ENTER 5 4658 uli 1 )C Gl 5 € s yi ) alia galads R 143G

A (e oWl Julatsa by aa e a3 51 0 :RecCtangle .| D5 b Jolaisa o

Page 14 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

{05l AT & 5
|

Button

$Ribbon: Home tab » Draw panel » Rectangle

$©Menu: Draw » Rectangle

£ Toolbar: Draw l:T

E Command entry: rectang or rectangle

) yal 0 said
5038 Qi) D Cobie a5 wiS (o Gl J gl 4d S ) sie ag ) adali S ¢ g sl a) ) s
sENter o) s sk gl o il ol sie 4 Jg aae laie o S 0 )l L sl 55 e Jls, aiS e Enter
o2l ansy dabais YISl Lc )y Enter 528 3l s (e g0kl () sie 4315 50 200 Hlaa s Jliso

A SIS s i dndia ) adals (S (55548 Sl IS T 6 38 ) 8 6) 525 e sala ilad

i 500) 1 SHIFT@ <obie gl 4i S (o)) sic dadai (SO 50 SIS s 5 gy &) ) gD
S Enter i) )0 5 28305 1) dilaivss (e 5 sk
DA Le LAl o)) ClilSal (5 pm S S s (e j3 b j0 Rectangel U x) i) j‘d&g)g\:wﬁﬁ

- aS Gl sald

““Command: REc

RECTANG

ey Andia 50 ¢ )l cpl GRS ) e b 4SS a5 Jalatie SO 2l 55 e Calise (il 0t Area
O D3 ) il 5w i) (Area ) A e (s 5 wiS QAT Jgl 48 K a5 jabas 8 Sy
58 oo gl ) play Sl

Page 15 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

i

‘| Enter area of rectangle in current units <100.0000>: '

Db LaS bl o ala jea g Ba )y i) g i€ aslg ) Hhaia ) e Galius caliy (nl caalia by
ET I NETD

&

| Calculate rectangle dimensions based on

Cialise danlae U i€ QLA Ui gl sie 431 (o b dsh)e Sl ) (So Gl (e L calay ) lsa 0
elaiona 525 3 1 il 5 0S5 1) phaia ) s s il ¢ Ll 1 (S0 Qlamil b ca s lusa o o 131 (sl |
R

a0 ) ald ag gl ) nt aan i a8 0 ) ) el a0l 68 e 4 Rl AT b ;Rotation

S ol s i o808 > s 53 iy 6l 4 8 () ) )55 o= :Chamfer

7 a4y G el Sy a1 Julaiee il g3y 48 255 e saldind ke 34 R ol ) :Elevation
(35S o2aliie il 65 (e (sam A slad 3 ]y IS Aaiil) S s

A€ 2505 538 2 8 a1y plai 3y 50 plad oy (0 48 NS s pans 53 K (sl @S L ) Jibatsa :Fillet
i3 5e sl 5 2 i) ) sie 4 ) (5 1e Jilaine o shad 4y i) 55 e 4k Rl A3 L Thickness
gl& ) ) da ghad Jadd 4S 203l 4TSI Ax ¢ 4SS () dn 29 (e o8l (m d slad o IS Aaii A4S 0K
Aed i solid b 8 Julatie 5380 e

S e J RS e s 3 Jibates da shad sligy :Width

= e alaione Clagdaii (lea L (1 clady 5o e, 58 QAT ) s 4838 3 alaS 58 a8l 5l amy 1 g 435G
S i (g 8y il 4g | a5 i€ QAo Jlsa 1A 8 (les A4S 250

Page 16 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

/ :
S(G)&)Chamfer T siwa b (Ll

AR e )8 ealdi) 3 se Classs 55 S (33 ) s Gl

:))de\ﬁ\&\.&» Sl
I/_

Button

% Ribbon: Home tab » Modify panel » Chamfer and Fillet drop-down »
Chamfer
¥ Menu: Modify » Chamfer

¥ Toolbar: Modify |

st 1l o sl

G 1o i) se a0 50 51 can ) Sl 5 aiS Guls ), D @be « Chamfer ool O oy
B

O3S 2l b e L)€ a1y asdien) gl a8 HE ) sl clla o alias s alia
o @l W€ Sl sk o ) g alae) s Fan ) et s ) s daghd daalal ja | (i) b ab e
SAsd e diad Jhm ISS by mSaSa

Page 17 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010

For Evaluation Only.
Db ams Al YA () e 2S a2l 55 e S g g ge 50 Gl ) I ) D) Led s i
NGy D). WS SIS ¢ simga 535 2 5 Jhial )y pale Nl g3y 3 D Gjle s
1 Jhshd Jb 2l 55 e pd g samge 93 il Gl (8 (e LIE skl 350 Sl (D a1k

A i |y ) Crand 5 a3 (EAIS N5 e b 5l 8

123l e 1)z a4 Chamfer )l )0 aee sla 4 8 S

~ CHAMFER
(TRIM mode) Current chamfer Distl = 1.0000, Dist2 = 1.5000

Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]:
TR & [ [ T T | e

Al S el eadalail dee ()37 :Undo

) 2 4S Gy sealyl 4 358 e saldin) Polyline S W &S 03 & 64w X ol 1z Polyline
35025 B YU 534S Hlai o 5e jlie G 52 3 1 i ¢ D i 5 Chamfer Ll las)

O sla w8 olaic Polyling 50 SQS L ds casi o) il s i€ Gl 15 P &jle (580 aglal

.q};}.waqj&g

Page 18 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

I

selecied polyline result

4353 08 2l s L alaald (e ga 5 Jsha 53 S 2l 5 L alaald cpl o) caidaii () 0 as 8 o) ) :Angle
..J}a.::a &R sAlatl

chamfer distance

firat selected

) ~ |
second selected 4:' angle

L2 g C8da Chamferjjiuqel;j\j\Aggidﬁswd)ﬁ\J&}gyau@S@ﬁ&\ :Trim
oo Ledi 4S8 2h e Cada e =S il Chamfer L siws Juee ) ) amy ey (¥ 43 B aS (g jlatlea 45

S Tada )y Ll )y (s, ) 2l
)WL sl Ghgy Healdinl Ly 30y palie g S QA ) Chamfer ) ) 4Kl )l

sl Ol )by Ban o)y i) 5 S Qb)) (Trim) T <obe s S

+

Enter Trim mode option

[ Trirmm

No trim

Page 19 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

e i€ S o) Uima (l 4 5 280 (0 CRTITYIM 550 pad Gy Glla 50 1ty (048 (5 ) shailes
= 8 =S Chamfer L siws Jlae) ) ae a0 sl 1 No trim 4w 8 S s ¢ aS Cada
il

&

S Juad e b 5 Jlad ) gl Gl D ) srde sl Sl il 58 (e Ladi z age 4355

1 i) 5 S uli ) 0 23e laie S Jla e e 1) i 5 4 quli | TRIMMODE <&l 1
O i)y il gea Sl ] e &1 5 atile e (Bl i Jles) ) am s S 2
gd e Cada W =S Chamfer L)yl e

O aS il aldbh as g S Qlasil )y Angle L Distance stla (i) ) Se il 58 :Method
A< 298 e saliind ) 8 Angle ) s 2sd (e odldin) J gl aliald ga (ala ) Distance
sl e 4l G S )5 Ll A ) a s ahim abiald 5 all (Jshe 6 ) J) el abiald

O 253 4 38 iy Jleed Jb a ) ae 23 sadi aa gie 81 ) 4y BaS o) shiles :Multiple
VA s aS Jleet 1 Gl ey 5 2058 QAT Gl o lsd Gy (0 4S 258 (e sal ) s

1) Ol Gl A8l (5 0 S Jlee ) e gimsa 5 a0 e a1 1l c) 4S 2 )ls Sl Sl 5
) AT ) sy el S 050 5S Jlad (sl . i€ QAT ) 4k R ol il 55 e e Jlad

Cpad ) agh Jd UWan )y il g S i) M Gbe il g3y s Cha B L 5 Chamfer

S ol 2 55 (e S Jlad e () Gl

Page 20 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

N i
D(L &S 08 2 5 FilletLsiwa b (Ll
08 e )8 ealdinl 3 ) gala € (3 S 3 S sl ) o) )

5| BUR EXt g Py

4

|
Button

% Ribbon: Home tab » Modify panel » Fillet
% Menu: Modify = Fillet
% Toolbar: Modify

Gilie D @lie quli (sla 40 4S 2l ol b 28L o Chamfer L1l aiile ) ol Ja e olas
G iy 5030 1) il o sl S alg ) ki o) se plad il 50 2 5 2nS Quli Al o R
S SGlS el (54

-1
.'r 1
/1 |

, P 4
i O | >
I~ S— %—f’.’

1 \ I|
\ \

~
3L o Chamfier i dille 88 514 R (il sl 4e sama 321 e 4550

Dsid 5 st Gl Jleel (K8 Ka () Cle singe (55 i o) 50 sl Crand AT ¢ g 450
8L (o0 pge s Chamfer

Page 21 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

N .

|l/ }

N \.

I'-x\h\ ) \_J./II
| | .Ir_
\ \__/

selection points result (with radius greater
than 0}

s Fillet Juee) Sl e 23l 55 ad )l 3a) (al 4S Cand (pl 2Bl il 4 58 s ) 0l () )2 48 (6] 4355
A e Jeay ot 4 | Ll eSS0 Ly a8 aiS Cada |y o cldlial ¢ oyl

Y

N N ,>_<; %
I
. N
r,/"“:;{ ™ / ){ \
N |>£ ,/" \_ K J

f : Blend Curves 4S Caul 02l 48l g sana ) Gl 0 s (86l S0 2012 S50 6505 0
A oe ol Aate by ghad 93 g (spling )iaie b G a5 ) e ) o) OV aS bl
V) QA g

J

d
1

Button
¥ Ribbon: Home tab = Modify panel = Blend

% Menu: Modify = Blend Curves
& Toolbar: Modify

Page 22 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

S (o Ay ) ) (b 4 2 8 (e 38 A 00 s BL G ke i L
: salail U':‘.‘JJ

LA ALUE WS SIS e pmga 50 59 i i )l Gl AT ) e aS 280 e G g Gl 40

S Jeas 43 ) Ll Spline < ¢ Ll i 5§ paga g s

() e s (S)OFFSET &==_) »l L il
D e oaldind Gl el aa b jiwdaghd b g S jean sla ol alaal o) e ) ) ol )

T
b 4

2 ) ) ATl b gad

0e

———

Button

% Ribbon: Home tab » Modify panel » Offset
% Menu: Modify » Offset
% Toolbar: Modify

Page 23 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

a}.&ql;g\Qia\j\y)q&}a}ag\_;c\SULg\d@léJ\&U\J'._’\L')_.;\g._rlsﬁ\qa__a;J}'.mgd\);\aj;ﬁ
ol Ly Jla 60 58 QAT U S SIS R0 ) 50 & sadage (550 Gaps 5 38 30 1) il 58S 05050

2 on Juee) st cpl ¢« aga 1 5 UKL 5 € Cppumt |y Ja1 3 ) g g s 5e

z

b aihe )l Gl sl 4o gana )

ada Offset ) am Led Lual U eliia ¢ guin 9o 4S 205 (paand 20l 55 a4 R ol ) o2l b :Erase
3

2038 OFfset £ gm0 48 283 (e | ) Gl Ladidg 5 280 (e 2008 a4 R S o) - Layer
Sliead b satb ey e 3% el el 4

O 2 iy e aS (5 shailen ) Glaitlu saiy (ST (3 Ol 55 a1 Al Gl )3 eab Je S
OO aan Sl ) o8 5 Osmlaid (Bl 5350 e a4kl s Jad b dashad Glaidle ok (S

L 4S i e 250 Offset o e 40 s ST O ) el 81 dla 258 (e pas yi (23 (]
a3 s K sl )3l b1 o shad Offfset s Cauls (0 4S 353 (e pans i abaii g Jad (led

) okl 3 U8 Al 310 3 ga g AS (5] AT S ol L Eolus 40 2l 5 e )3l ol L 4AS Cane L)

A ol Ay o sadbadale il o slne) Y )l o

O

Copy () s

J):SGAJ\_)éoJ\s:\u\JJ}A@MH}Q\L}AJAJ&&\}J\JJ\LH\J\

Page 24 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

st 6 al sla Al

Button

% Ribbon: Home tab » Modify panel » Copy

% Menu: Modify » Copy

% Toolbar: Modify

Shortcut menu: Select the objects to copy, and right-click in the drawing area.

Click Copy Selection.

o5 ) ) o s
Iy le paga g g ge ubaS Al e d A Clla 4y (e se slad S ¢ sid QAT ) G
SS9 Gy (0 4S 20l (e 2 Ala je 3 ) O 5S) A0S QIS sl ) Las | L) 5 auS el
) A (o dS e 4y | (use L adadh QAT Ly 5 aiS Gl oS G b B Ol sie 45 4dads
Mﬁ\)éd}k&\jﬂww%@Eﬁd)y@)djad\dﬁﬁmyéﬁbyﬁ
A0 1 Tl el 5o 5 S o)l g S SHK sla
N 777 |a N I

N

e

b A jbe Sl ) Gl de sena ) (n S aee

A e o2l |y ArrayAi R S o8 gle i dad 50 ey adads QA ) oy S

Page 25 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010

For Evaluation Only.

“Current settings: Copy mode = Multiple
Specify base point or [Disadscement/mOde] <Displacement>:

Specify second point o <use first point as displacement>:

4515 [ ol 1 [ = [+ 1[0 [ [

A Sobe bbb aS cArray b s i€ QAT ) gaay adall ) & o Led ) Qi 3 (la 8

o5 ala by 3 ikl (52 ) ey 4l 48 e 180 (S Cpdia (U g gumge )il 58 e ) 00

4&

Enter number of items to array: Ii|

2 gt anl ot WA o)y i) g i€ 0yl g ) ) alaad

)l (g 50 abad (ol () s O 5S
Ml & gom g aAliald aSl (5 B0 a1 i g 2 0 )5 1) G adall 53 G alald aSal S
1) S abald 5 a0 5 ) il 5 a8 QUi ) F <jle i) ol HIS ol (6 048 S )5 1) (Sl

S SIS s Jidadia joly g aiS o g

Q) o h__ )
QA ><fr \\-;J h -
(:;/ 9} . l

5 copies fit in a linear array between the base point and [/\\5
fe— .
second point

: (Erase _@) b5 aas i e gum ga ida Ly LS
PR g5 S5 50 end s i e i ge 03 S SL ) L) sleal

Page 26 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

2Ol ) QA 6 gal

% Ribbon: Home tab » Modify panel » Erase

£ Menu: Modify » Erase

£ Toolbar: Modify -é
Shortcut menu: Select the objects to erase, right-click in the drawing area, and click
Erase.
E Command entry: erase
el aVla
k_ﬁlA:Li\ QLC}A}AUJ.UJJ\J Delete JJW}DJJS&J\A:\J‘HMJSWJJ \J&}my \.ﬁ.}\-l
SHASRTEN
A gl Cada oAl
MDQBJJ)MDQ}%L_!M\ \Jera39}°3)s‘r’&j\ \JQ\L}A}AL}&M}A \.ﬁ.ﬁ\-z
BIBY
(e 1) il Ll ol
GUENter -Euli -Ale s s by g puim go A3

HE'“’J_‘ ‘k_“””_]
1]

e |
HL: zl 1
T
~ ~

Page 27 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

: (MIRROR) ﬂ“l@m@)g D s
& (on 1A ol 2550 g0 i Ly (S 3 Bl s S L 02 S 4 B (51 s

2Ol ) QA 5 gal

AN

Button

% Ribbon: Home tab » Modify panel » ~ » Mirror
£ Menu: Modify » Mirror

£ Toolbar: Modify ﬂ“i\

EE Command entry: mirror

s () jal e el
b Gl ) SIS s 5 S QAT ) Hlai o) se e gunge b saage ) sisd (53 S Jlad Sl
OO ) saa & gl adad () sie 4n ) adals S b ala je () 5oL sl gamAla je o)l B o
L i 5 (S Qlail g )l aladh (o 1) el by (Pl adals (s ge oS Lala b (s 5 20 Al

A8

a3 Al |y Sl ) i€ aiy i 1y i Cle g ga i) 55 (oo L i b Gl Gl 0 ¢ age 45
D ) p el e S ooaLiie il g8 el ¢ e ge (8 DIA Clla 50 (5 i s

Page 28 of 167




Edited by Foxit PDF Editor

Page 29 of 167

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

+
AutoCAD2012 ™

D) e s 51 3 358 Jlael 358 e e pnsa 5155 )3 0 5 23805 45800 2 ek S

S Jlad )y esie ol Mirror ) saldied ) Ji8 aS 2l atdly aa ¢8| S salai

oy Ban sl il 5 S i gle 8 0 ) ) MIRRTEXT b il 0 S Jlad 51

+

ot R 5355 cadaia 358 Gl 50 e g pmge e i 1) Sl 50505150 e 81 s

129l llad

Enter new value for MIRRTEXT <(0x: IIl

S Miiror 2l 5 e ) (siie & snge 2y 1) Si) S0 )ls ), ] lasa

k3 CH R
+1& Vil+ +av
10K X0t 10K

before MIRROR after MIRROR ater MIRROR
(MIRRTEXT = 1) (MIRRTEXT = 0)
+

= -
(S ls) + Moveol b (Sl
4 adadi (S ) Ll JE) 5 e guimga oS s (o) 5 230 (e g3 o ealiiud Ly ) 30l S

AR e ) eldtal 3 ge 80 adads




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.
2Ol ) QA 6 gal
+
O
+

Button

% Ribbon: Home tab » Modify panel »Move

% Menu: Modify »Move

¥ Toolbar: Modify

Shortcut menu: Select the objects to move. Right-click in the drawing area and

click Move

1 sl o sad

ol ) Sl 22y 50 S Al | Hhai o) 50 e guaga by & sua g0 « MOVE D) 3) 02 dUad ) Gy
)y adall S G 5 03 S SIS e Ly Lise adadl 0l gie 43 JSG ) adadl S5 (55 Gapes 28 il
RS el JEE) Hh000 ) 50 Jae 4o Dile s ge Jae () b i€ QAT aaile ) sie

_ﬁgww#@co\}b@d)\%g&\:w&

14

 Cor

<

Page 30 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010

For Evaluation Only.

(02 ¢ls) Rotate O Db Sl
AR e B saliu) 3 ) e Cile gua g (SR a5 Ol sd sl <) 30l )

5" ) 0 g3

O

Button

¥ Ribbon: Home tab » Modify panel » Rotate
% Menu: Modify » Rotate

¥ Toolbar: Modify
Shortcut menu: Select the objects to rotate, and right-click in the drawing area.
Click Rotate

)l ) yal e g

Sl ) SalSany 503 )8 latil | Hlai g ) ge Gl gia sa b g gia 90 « ROtate )l 038 Jlad ) G

58 a3l s 1) Olse e Gap 23S e QAT 53 (slise Ol s 4y ] ) adadi S ey S il

R el Gl ysd Jee iy a1y il

AT ) amy i) 58 e 28l 4830 (S G O ) g s s o8 2l 534S ) saa ok
O 2025 ST ¢ giage ) dee b ai )y i) seasai )51, (2 ¢ s =COpY)
C Cle i o) 5 Lk

sl e 438 5 (S Sy

Page 31 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

"\
A

U [,H
[ x[
“w ™

|

: (c‘):s\d) Circle @ BBt L @L\.JJ

AL e a8 D gldie sl il ge s OV )3 4S 8L e 0 ald aan ST ) s ) O

: a),g\.l J\).a‘ Ay 6 g2l

@

Button

% Ribbon: Home tab » Draw panel » Circle drop-down
£ Menu: Draw = Circle » Center, Radius
&€ Toolbar: Draw

AL e g lad 028 )l 5 38 e QAT Sl ealdid by o () 5 ) s

B o) sie 44kl S5 555 ¢ (Center, Radius )l 3 A ) ey a8 23k 0 &) s () 4

A ) S S a0y i a ) se plad a5 03 S SGIS s i

Page 32 of 167




Edited by Foxit PDF Editor
Copyright {c) by Foxit Corporation, 2003 - 2010

For Evaluation Only.

% Ribbon: Home tab » Draw panel » Circle drop-down » 3-point
sl e aa il adali A 50 QAT ) G Lad Al ol

\ |
N ,/\

% Ribbon: Click Home tab » Draw panel » Circle drop-down = Tan, Tan, Tan

Page 33 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

o_nld (b ans i Ciga (lan () sie 4 g saia g A QAT 4 Hli Lol s 58 5 (gl b

ol

N
W

A,

©

¥ Ribbon: Home tab » Draw panel = Circle drop-down » 2-Point

Db 0 a yio il adaly gy jy AlAT L

¢

% Ribbon: Home tab » Draw panel = Circle drop-down » Tan, Tan, Radius

P g g ol HhI 3 ) se pladi (3 5a3 3 )l 5 ules 93 AT L

Page 34 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

: (US)Arc f/‘ el b sl
A8 e I8 ealiul 3 se Calite sla pladi b (o W 5 LS i 5]

2 ) 3 lAn) b gad

p

Button

% Ribbon: Home tab » Draw panel » Arc drop-down = 3-Point
% Menu: Draw » Arc » 3 Points
% Toolbar: Draw

: \_);\ 5 g
S () sie 40 |y AL A a5 s ¢(GAS)ATC DB 1 g 1 )31 a3 s 5 Jpmme s
BEC

s aa i OlaS U oa gad QAT laS (g1l 5 S e
Page 35 of 167




Edited by Foxit PDF Editor

start{1), center(2),

end(3)

N\
S *’if ‘\_i__if'

starl, center, angle

Page 36 of 167

Copyright {c) by Foxit Corporation, 2003 - 2010

For Evaluation Only.

—endpoint of line

Y

Sa%
N
il

A she OlaS a5 Soa sl iy

(OLbe S yaeg 5 5)Start, Center, End

Ve k
‘<<

Y

</ 2
center(1), start{2),
end(3)

1

D (US4l 5 S e g 5 x5)Start, Center, Angle

|r1c:luul::|13r::|J

angle

center, start, angle start, end. angle

(S Jsb 5 S e 5 45 ) Start, Center, Length




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

chord length
1 1 .
-.Ixf’__.- \.f'l i \\_ i W

! - l".,

A
'\. - I -‘\ /;‘-.
! ! P
\ (L2 SN N
chord length
start, center, length center, start, length

D (UeS a i Al g Ll cg 5 ,4) Start, End, Direction

i_l &
| _|f"'_"" 2 direction
1

slart. end, direction

s (OWS glad 5 LW g 5 3 Start, End, Radius

start, and, radius

: (022 4alal) Continue

A a1 a1 ) s by (8 LS dalal a5 (e gy o) SRS L

‘(oie)Scale Iy b us

s oo oalind 008 an 51 Cile ginge 92503 K 3 5 Sa oS 51 (ol s )30 G )
2 ) 3 AT b gad

Page 37 of 167




Edited by Foxit PDF Editor

Copyright {c) by Foxit Corporation, 2003 - 2010
For Evaluation Only.

=

Button

% Ribbon: Home tab » Modify panel » Scale

% Menu: Modify » Scale

% Toolbar: Modify

Shortcut menu: Select the objects to scale, and right-click in the drawing area.
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% Ribbon: Annotate tab » Dimensions panel = Continue
¥ Menu: Dimension » Continue

¥ Toolbar: Dimension
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Button

% Ribbon: Annotate tab » Dimensions panel » Center Mark
% Menu: Dimension » Center Mark

£ Toolbar: Dimension
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o

¥ Ribbon: Annotate tab » Dimensions panel = *| = Dimension Style
% Menu: Format » Dimension Style

¥ Toolbar: Styles

B Command entry: dimstyle

II“'I‘\w’?‘ HE DR A | E P @A A | Itﬂ

2 9d e Ol ek Ol Gl 55 SIS Sl any

[fﬂ Dimension Style Manager li._E-J
Cument dimension style: 150-25
Styles: Preview of : [SO-25
£y Annotative Ll Set Cument
[50-25
L
k- o
¥ 5
'
D\rernde
'C'" Compare
&
List: Description
|S0-25
| All styles
Diont list styles in Xrefs
Close ] [ Help
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1 g0 Yol o gl eal (S g e ety 2 ) B i€ SIS Modifycs sy s e s ol 2

[ Modify Dimension Style: 150-25 [
| Lines | Symbaols and AlTowsl Text | Fit | Primary Linits INtemate Linits IToIemnces
Text appearance EWE]
d
Text style: Standard - D
Text color: [. ByBlock ,J E‘ )
e N
Fill calor: [ None - >
| J g
Text height: 25 =
o
_— : o
Fraction height scale: 1 - @
[ Draw frame around test Text alignment
Text placement Horizortal
") Horizortal
Vertical: lﬁbove - J
) @ Aligned with dimension line
Horizortal: [Cerrtered - J
View Direction: lLeﬁ-to—Rjght .J ~) 150 standard
Offset from dim line: 0625 a
[ ok | [ Cacd | | Hep |

o)l ok fia 5 el TeXtS yoym 3l i) a8 Cand cpl Calls (o yign a8 Jls sy Cl 4S8l ) amy

Dl oo Ll (i e 40 By Gl 0L gl ) ppt As gie g B S Gl g )y

.LS:LJ‘;ADJ\AJ\LAUJAML}JJALM&)J}&UJ\**
S et ] 5l Jad ie b g e 3l A ol 3 Text Height

A€ aadaii Centered 4 X 55, 1oVertical w4 X o) «Text Placement < 5o
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o 3l ad 4y i | (e (548 ) i aliald it Caly (e Caandi () 0 :Offset from Dim Line
Cal yigr Crand ) 50w S el Centered 4u R 55 Vertical Caesd )0 (a5 A€ (sl
2133 R 35 e Ly o 3lail Jad Lo jlail (e B i€ a5l 515 0.01 22
GR35 S ) yiea o jlail ad 0 gd L)) o jlail Jad (e il 65 e 50 Text Alignment caeud )
o )l Jad Uy (e 48 258 e aely AT o) 284 e Aligned with Dimension Line«s S
23Rl siea

12 95 SYmMbols and Arrows <8 sy 3 ) s TeXtS yia 50 &l s aladl ) sy
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Lines | Symbols and Amows |Text I Fit I Primary Lnits IAItemate Units IToIemncesl
Amowheads
1,02
First: k1.0
[ BB Closed flld -] T /\
Second: E o
( BB Closed filed - _L T
Leader: >
| BB Closed flled -
G
Ao size: Q(—:}‘ !
0.15 =
Arc length symbol
Center marks @ Preceding dimension text
None Above dimension text
@ Mark 25 : None
Line Radius jog dimension
Dimension Break Jog angle: 30
Break size: Linear jog dimension
375 = Jog height facter:
1.3 )~ Text height
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01 6k ) Carea) Caand 0l 4S s st ) ) ead ATl Gl s jla) 2 55 o Arrow Size
Center s )l ol iie IS 3 50 S Jlad |y Mark 428 55 Center Marks e 5o (s
.S Gued )y Marks

ol bd (il s e seada K ()L 2sd Lines S 2y &l s cp) Jlee) ) 2y
AL e o il adliia Lo glas

(A Modify Dimension Style: ISO-25 [
Lines |S'_.'Tnbo|5 and Amows IText I Fit I Primary Units I Altemate Units I Tolemnces|
Dimension lines
L, 0o

Color: I. ByBlock vJ
Linetype: I —— ByBlock vJ
Lineweight I — ByBlock "J
Bxtend beyond ticks:
Baseline spacing: 375 <
Suppress: [T Dim line 1 [] Dim line 2
Exension lines
Color: I. ByBlock 'J Extend beyond dim lines: 01 =
Linetype ext line 1: — ByBlock - —

I J (Offzet from arigin: 0.35 =
Linetype et line 2: I —— ByBlock -

[ Fixed length extension lines
Lineweight I — ByBlock "J
Length: 1
Suppress: [ Bt line 1 [7] B line 2
[ ok | | cancel | [ Hep

1218l e )4 R 50« Extension Linescuesd 5o 5o sai ol (s 43 R 0 i aea

OMa dx o jlail allis Ja shad 4S A0S el i 65 e b ) 00 Extend Beyond Dim Lines
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extension line
’—D'?E __‘ ’;D'?ﬁ overshoot
e ) )laie da Allio T plad () 4S S el 401 5 (e 300 abd o) ) ;- Offset From Origin

Primary Units 2l ol o) Lie) 5 e jiia C834S 10 S oaliia & st ) Jlee) ) G
L

a0 il el (BG Ba s 58 o)l iy 5 a1 ) s dad 5 il 5 e B e il 50 25

)
o
- ~
[A4 Madify Dimension Style: 150-25 [
| Lines ISymbuIs and Amows IText I Fit | Primary Units |.P|hemaie Units I Tulelanc:es|
Linear dimensions
Unit format: IDecimaI VI 1,08
Precision ID.EH] - I I
o
Fraction format: Horizontal 1 v'%‘:n
Decimal separator: " (Comma) - & >
Round off: 0 = o
oy
Prefix: &
S Angular dimensions
M rit I
Sssurement sesle Units format : lDecimaI Degrees VI
Scale factor: 1 =
[ Apply to layout dimensions onhy Precision: lﬂ VI
Zero suppression Zero suppression
[ Leading [ Trailing [7] Leading
Sub-units factor: Ofest [ Trailing
100 :
Sub-unit suffic: Dinches

[ ok | [ camce | [ Hep |
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A5S Gl Decimal (s olie ) ) aal s & 53 ald ol o0 Unit Format
salain) Slaialu slals (6l p )i\ 4S € Guet | Hldie lams yiea <8y a3 ald cpl 3 : Precision
A aalaii Hldie larg jauali o) (59 4S Gl yig 23S e
L s adaii by 5 250 J 58 Sl i€ (i | Jlde) a5 Ji o ©edle - Decimal Separator
A8 )l A alals S
N ed ) Hlaie da s jlail el (fie a8 A€ et Al 3 e 0 Round Off
S D)5 20 gl S0 1) (e (gl il 6 (e : Prefix

#1.00 |

S el 20 s S 20l 65 e 0 abd ) )3 : Suffix

aad )8 ald cpl ja ) o gl o lailind ol OSo Lad a8l ) 8 I AS Cad cpl 3513 dsa g AS o) Ak
Coudly (0 35S 3515 1l Caadle il 53 &) Qi gy, e84t s 4 ) O Jse 8 Lais 2
A LSl CuBle Boa Sl ald ol 315 %% co e

FAEL e )z b 4 2L e U5 JPrefix sSuffixalé 5048 xS Ll g
(°) =2 = %%d
(F)ie 5 i =%%p

(@) k8 =%%c

ol bl pln 8 ARY=\U+2248
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4 ) /= \U+2220

sixba =\U+EL100

S ebaly slau;aa =\U+2104

(U alen Cin) Gl s by 5 W =\U+0394
S b Sl 3l =\U+0278

Owoaba =\U+E101

(Sl ) Al b 5yl p Sladdie = \U+2261
adl Jsh =\U+E200

= \U+E102

IG5 sl L=\U+2260

(B 02 Caglaa aal ) 2l =\U+2126

(Sl SAT s ) Bl = \U+03A9

Gl b g asda = \U+214A

Ao (e p) 12 2 (A D pug ) =\U+2082

Cpsada Boa Kl 1) xS ol o o 5 0 QUM a2l 8 (e iy ¢ g e e =
\U+00B2

Wededly lalad a e yia

(YU sy 2iile ) e jie = \U+00B3
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WS a1 St a8 e e 28l 550 Dlie scale Ll LD O 38l A (e 05380l 03 S (5 IR
5 51 (e ) sdn Cumaca gl 50 K1 Jla 5380 e Glulad 1) 10 220 Ladis jlai) ol a3 dua

AES )5 1) (a8) 0.5 Jhate ald Gl 50 oy (e 0 LIS ) yie 5 a2 (les

saghiodly gl jldie) a3 J8 jhia 48 0 fpaat Al &5 e Caend Cpl 3 1 Zero Suppression
s oala Glnlad b

A8 (el el |y Jllie) Ji s ey K al 03 S Jlad ; Leading

A8 e Sl |y Jlde ) aa siea jaian R op) (a8 IS : Trailing

S S OK s ) ekt Jlae ) )

: MTEXT e s b (udd

\ﬁ\d\ﬁ\)@W\JJQQJ%)@\J@&Qlod)';(_guC)L)A%\l\)ﬁ@)\}\dﬁ\j\bdﬁim\@
A S

: J\‘}g\ t_ﬂa.u\ 5 g

A

Button

% Ribbon: Home tab » Annotation panel » Multiline Text
% Menu: Draw » Text » Multiline Text

¥ Toolbar: Draw

Pointing device: Double-click a multiline text object
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Ll (8 e 48 28l (oo O GRS S 5 (053 (5 (e Ll ol Jal aS 0 0k e (il X 30
DO ke

Displays menu options

— Columns
. . . Displays ruler
Displays Mtext Justification menu _l
Thxt Form itting ]
|| Standprd = || B Adal sla o220 - B T U O v o= B [Mbiayer ~| oK b
g~ | B~ | =| = = == =| I=~| =~| 08| Aa aA| @~ | gr00000 =] aw10000 =||o 1000
]
I— Displays Paragraph dialog box Save changes and close

first line indent

Change tab styles

ruler —l

|m I ...|..+|.|_.|...1_...|...|...|...|...|...|...|...[...|...|...|...|...|.i?|
Set width of the mlenobjea—l
user-set stops.

L Set lenght of the mtext object

(2l 02 S ) (ol S J8 ) Gy ) S ATl Ll ) 00 S Style

paragraph indent

S et ) e g 1L g6 5000 : Text Height

) 1) (mdige sladlel gl 53 2l 55 e 4S 230 0 SymMbOleoady Cn) Y pee s 4R K

Glilee U ai€ QIS LG S5l (5 S dndin A sliad 10 Ly SOK 5 SlS 5 (e (il g ) amg
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: Text Style &’ aa e S ciale by Ll

‘5..4\56\.&g_i_.\.utg‘)\smJdoiagﬁjld\ﬁbwjajh}\laiolo&\ﬁA:\SUSGA_)\_}.;\Q..j\j\
S salatal Ll ja g S alagl

2 ) ) QLA 6 gal

Ay

Button

% Ribbon: Home tab » Annotation panel » Text Style
% Menu: Format » Text Style
% Toolbar: Text

E Command entry: style

ol o ead

ol (on oady Ol (s 4 R (0 55 a4 48 258 oo Ol oyl ) 0l AT ) Gy
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A Text Style 24
Current text style: Standard
Styles:
. Font
& Annotative Fort Mame: Fortt Style: Set Cument
Standard I b shoc
[] Use Big Fort
Size . -
[] Annetative (i Height
Match test orientation 0.0000
to layout
I All styles v] Effects
[7] Upside down Width Factor:
1.0000
[] Backwards
AaBbC o
B T [ Vertical 0
A | Cancel | | Hep |

L A

oo b D3 5358 Jb (S S o jai SO U wiS QIS New (50 ol i o paiy (nl saaldia ) 2y
B e S (al 25 Al aaa e S S U S SIS OKes s 50208 )5 s ol S

S Gl s )4,

283 e el ) sy sl S ) el Ciadd ) 3 :Current Text Style

S Al ) k) se i g Al 55 (e Crand (l (58S Cad (0 S 5L L Font

S 3l 1 (e el 5 bt Height

S )l 3 il 55 e el Bl e Sl 0 pd aiali Lad (fle U S QIS oK (550 bkl Sl

S oliid TEXT b s MTEXT 5 600 baa fia cilagla
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55 a Layersal bl 5wl 53 e dashad (g1 5 aliia (sla JSUS ad 5 S 5y jade g
) Ay jp 4S 2L e 3l sladelS Ll aS A gt as Sl | la 4 chiida | S salétal
LAM‘)!L"_\;!L@_I‘)J)J\JJ\)&MY@‘)J\JMD‘FA@WQLAMA}UA\PL;\J\JAS@LGM}A
ub&\.ﬁ\.ﬁ"qy)\éﬁ)@&)}é)d}&dwm\J&\Sb&dﬁu‘)ﬁmuab)\)ﬂeﬁ&}}\J

,a)ﬁesuﬁsé}mja@)';)\ugmﬁbqwits

annotations

dimensions
objects

sample layers

i€ L ) Gy O edlial L (4 o ss e o yaiy b L 40 Cyy st 6)
=

Button

% Ribbon: Home tab = Layers panel » Layer Properties Manager
¥ Menu: Format » Layer
% Toolbar: Layer

E Command entry: la

sl 4 R (s 5 age 4348 255 o« 3l Layer Properties Manager s s (Sl o il L
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e Current layer 0 Search for layer Q

SR X & &
£& Filters «|| 5. Mame Q. Fre.. L. Color Linetype Linewei.. Trans.. PlotS.. P.. N,
=7 All [7]o ¥ ® o []w. Continu. — Defa.. 0 = my

£ All Used L

o
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g
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£

[T}

=3 —

E 1 | 1 3

E [ Invert filter (]« | 1 3

3

g All: 1 layers displayed of 1 total layers

aalal 53 i€ AT Layer 5alS YL 3 oSl el 0 s 4¥ S alal ) e - New Layer
) (oo plail g A alagl IS i (5 L5 S 3 ) 5 ead Al 4¥ () waa QLS
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A5 S 5 208 SIS ST Gl (55 2y 5 S AT ) plai ) 5e 40y
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Al ol Y ey o O o) ) SAS L ey 5 S QA i) s

coban e aS ol ) il 4y Q@Pﬁmd\ﬁ‘ﬁuj}\ List View Creud y2

AL Gl gl Y Al caad e gLl ) 4Y Cumaa s : Status

80 e pinlad | 49 WL Name

¥ o) Gle g ga 2l hsald aS Gl Y | Y SO 0 S Gl 5 s )0 :0n and Off
sl Y diiled 005 dania gla Y 28 (o B ealiiul 3 50 43Y S (28 2eaie )0 :Freeze

1) JismalS e ju 900 S5 S )b Regenaiile (1) sl 50 4S gl ol by S oo Jae (i ga&
A3 (oo Bl yiaS

By 02l J8 Gl guiaga a¥ S 2 Sz )& J8 )L 5 0 S Jé :Locks and unlock

AL e il g

Y O 43 Ja 52 e e samge (5l 2155 o 5 25 (e S K dpma i () 2 SIS L :Color
(S oliinl Index Coloralubiv) L&) H ol yigr) 2 cpad Ko ) S

A Guad ) ek g g anil 65 e Caand () 3 :Linetype
528 SIS Load (5o 2383l el a1 phiaysedad 5o SCSQISasy R ol (55548 il
S IR L1 ki g ge bad

S |y O daghad Culaca 30 Cuwdd ol )3 : Lineweight
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A et ) dagad Sl Gl g Cudled Al &8 o : Transparency

Al 5 adl iy QB Y O Gile sin g0 4S 208 e a0 55 e ST Gl 55 SIS L : Plot

: Microsoft Office s )38l a i L aS gl Sad Ko &a b ol

3y Sl B aas e )y 8l Gl Ladi 4y 5 280 e X gl (sla Caand 0y 5 age ) (SS9 Caand ()
5 2l 0 B a5l e O 4n (sl o L S Jadd Caand (ol 50 nsd L 5 Excel b s Word slad

S a4l a0l
= Jilé sliaa 4 5 230 o Object Linking and Embedding <l <ésa 43 OLE & ke

D)8 S plad 5 20 Ll a8 i jla | Ol gl s 0ad o K00 (sl Ay 5048 a8l

sk
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=
[aa] 3
Button

% Ribbon: Insert tab = Data panel » OLE Object
% Menu: Insert » OLE Object
% Toolbar: Insert
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Insert Object [

Ohject Type: 0K

@) Create Mew KzGetE Document

Microsoft Equation 3.0 lﬂl
Create f Fil Microsoft Graph Chart
AR 1 oot Office Excel 97-2003 WorklE

Microsoft Cffice Bxcel Binary Waonksh
Microsoft Office Bocel Macro-Enablec Display As |
Microsoft Office Bxcel Waorkshest ISpidy na lcon
Microsoft Office PowerPoint Macro-B ™

Result
Inserts a new Microsoft Office Bxcel 57-2003

Waorksheet object into your document.

L

A

OLE o) sie 4 a8l 8 (o Jamads ) 0 et il 5§ 0 Object Type s joe aby ool 2

DA e a8 008 woald Gilad (e Al o iy (b 50 AS 2B ARSI s 55 b A5G (gl 4y Hok

S il S 5y ada o peEXCEN 4S il 53 &) JUe () . 2L 028 sl Lk gssas (55 1

«l% OLE
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4 008 G Q8 (OLE g sa90 550 Open_siod ) al LaS as el oSl ol ladi g 4y R

A5 aalsa S ol aalalddl ead Jle ) &l s 5 23wl 52 3L Update &) s

Ol 3 1) Excel el e ), 253 jhidama ol U i€ SlSe OK 5 )0LE § s 00 AT )
(eJJ)SQ_lLA:U\dLSA

Bookl - Microsoft Excel | = | = |&I
g Hu:ume Insert | Page La | Formuli | Data | Review | View | Add-Ins || Autode || & '@' o 3 ER
i @ G
GoTo Log
Vault  In kd Help
ACCESS Status
c12 M S | =C8+C9+C10 v
A B C D E F G H T
12 abgn (30 Cimdias
12 4dia el Calies
10 30 ey Tl
11 -
12 I 54! P pazea
13
14
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R ed AAlu ¢ g ge O B i€ QIS o gif dadin ) Cuand SG 53 368 Gl (A6 )
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€ LA | Al 58 2l 5 e 258 Sl 4y 4 4S 358 e el B0 48 R (pia

10 & e | 2lsd B0 Dal
Repeat OLESCALE
Recent Input 3

Clipboard [

Izolate r

_‘é Erase

-+
+2+ Move

S5, Copy Selection

E Scale
C_) Rotate

Draw Order »
QLE :

OLE ] Open

@3 Add Selected Reset

ﬂ% Select Similar Text Size...

TIy Deselect Al Convert...

Subobject Selection Filter r

w Quick Select...
Properties

Quick Properties

slad 3 Al s () 5 i€ Jlaed | & juad Al 85 e 5 29 (0 OLE Jame 25050552 : Open

S8 e Jlae) G S g Ll

Al S e ) ead Jleel @l s :Reset
A |y (e o 3l i b il 5 e 4k R Gyl QA L : Text Size

OLEg a0 21l 55 (o0 5355 o Sk CoONvert e sk Sui4s X cpl 55, SIS L Convert ..

A B g s ge Soa daii | 28
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Convert @
Cument Type: Microsoft Office Word Document
Object Tpe ——
Cancel J

[ Microsoft Office Word Document

@ Convert to:

| Microsoft Word Picture
activale 39 (7] Display As lcon

Rasut

Permane'“l', changes the selected h‘ﬂros-o‘t Office
Word Document object to a Microsoft Word Document

object.

t AREA S5l 0 0ad ams i Cile g ge Cialins 5 58 o jlail (S0 S b sl

2 ) ) QLA 5 a

[

=

Button

% Ribbon: Home tab » Utilities panel = Area.
% Menu: Tools » Inquiry » Area

:\J;\aj;j

231 ) el 53 5 2 CSUIS o i 53 e g g (sl S ¢ i du L)) o) ST ) G
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Specify next point or 10.0328@

O 80 adlie o ani by 5 GleS (511 O B Caandi ) any )3 Ladi 0a ap 5T ¢ gaiage S) HHE

1 O aalise amy 5 )50 50 da LG clla a1 OF il Cuadly (e Cl s L ol 2 580 Gl s (g

sl

Db adh el dlla cpl sl iyl g S b)) BO Gobe WL Sl )

-

If‘. Boundary Creation 2

1'}—:| Piclc Paints

Izsland detection
Boundary retention

Retain boundaries
Chject type: Polyline -

Boundary set

lCurrent wviewpart v] @ Mew

| oKk || cancsl || Hep |

~

L

Ay (slizad (550 x5 2 g Ay U8 ga 0y () U S SQIS Pick Pointses sy eoaty ¢l 2

oobisa Ui s ) i) amy 930l Joad (e Jad S0 40 U S SIS 0 gl A LSO Al A4S o guiasa

P A LS80 & s e U aiS SIS OKG s, S ooaty 0l 02 5258 Jhada sy e oy
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S0 s wS b1 (Object) O “aa axy 5 2iS Qi) | ) Ared ¢ g sea e (2US 4 s D 2

A0 inlad ) O Calue B i SWlK g g ga

DS o R ey b S

: J\).I\ A 5 g

Button

% Ribbon: Output tab » Plot panel » Plot

% Menu: Application menu m » Print » Plot
¥ Toolbar: Standard
Shortcut menu: Right-click the Model tab or a layout tab and click Plot

ol o e

1 o L) (i age 40 a8 058 e phlad ) Slakaii o jaiy Plot ) ) QLA 1 e
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"
[&5 Plot - Layoutl &J
(i) Learn about Plotting
Page setup
Name: |<:None:> A | | Add... |
Printer fplotter
Mame: |@ Adobe PDE v| | Properties. . |
Plotter: Adobe PDF Converter - Windows System Driver - by Au... — 210 HH b—
Where: Documents\*, pdf £
Ira)
Description: ~
=z
=z
Flot to file J/
Paper size Mumber of copies
A4 v 1 =
Plot area Plot scale
What to plot: Fit to paper
Iw—v/ Scale: | 1:1 - |
Plot offset (origin set to printable area) 1 mm >|=
x. 0.00 i Center the plot 1 unit
y: 0.00 mm Scale lineweights
Preview... Apply to Layout oK l | Cancel | | Help | @

L

4

Cal Jom g Lo allssas 434S (5 iy ol «Caandl o) 51 Name 4 X <l 3 :Printer/Plotter

A Cad Gl IS (51 2eS Joasi PDF Cae i 4o | 253 Jild Casl g s iy o Lad RSPk
Jeasi PDF il 43 oS g0 Jié 5 2 sl | ) DWG To PDF .pe3 4R iy ol cused sla

PDF 4 xal s o)) 293 Jilo aS al&aa a8 Candl ol 2503 dga g aiy R ol j0aS g sy, a0
iy s Sla) (o Ay ol B AS 3K AT |y (53618 Myl (BE1S o 31081 (e’ Caansd 0 (2 Joagd
\‘)JP.AQ\.SJyaHuJ\JJLﬁiJQu‘):\A 33;\5):\Jap@um\jﬁ)ﬁ\dug\}m)&.\

AL e GRS Oy e Led HS QaS G a5 A0S Gaed A3

Ayl 5 3618 ad iy 5 S Sa ) iy Gl S il 55 e Caand (0 :Partial Preview
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el aladl ) e 3 Gl jued g i€ saaliia Sl paan | AL e iy p B AS ol 5 S

F— 5o —3

110"

A Al Hhaia ) e 2 1S (el ol S pdS Gl )2 SQIS L 2 Paper Size

44 R Ll ()i age 48 256 e (el 4y R Cpaia hand () 988 Gl ;0 SUS L : Plot Area
135048 3l Ly (Sl 0 Lah 5 355 a4 U g s 4 ) AT L 280 o Window
iy (slmd Gt ) a2 QLA 0 ety S0 a3 Ly 293 488 R iy abile aS 1 licad
s e Jhe il

S e a8 Ll JA8 B a3 ) Center the Plot 4 % S Lia Caand ) 0 :Plot Offset
A8 B iy sl 28

8L Ju=d Fit to Paper 48 81 i€ (et Sy () 0 ) 488 (il a0l 55« :Plot Scale

Agr ) gh (ulila (o0 g 3 gd a6l aa Lad 2 1S ala) L Lk W

S ool 253 (5 0 55 (51 Wl 3l s bl gm 53 B S e S |y oS il aobus 4355 i Ll 0
by aladil 4a ) IS gle Jilaa L

Sl IS L5 K b4y aa b s ailie Gile gimge B aSh St &I o5 O (An
D0 G ) b 55t ARl A4S 3 s ealiid () 55 (o QSELECTE?( D3 ) et sl 355 00 pnS
B sl G505 02 Ay 28 b Dle s e a e AT A ) H2 6B )l S Ol s A )5 e

J\).I\ug\ebW\DJJS}@)»})M\J}\}MJ%\J\‘)J\Sw\é\sg&u\elﬁ:ugﬁj\).\\
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528 QAT ) & sain 50 S av i dadia ja 100 )l gl ) ealsiul 6 234 o« SelectSililar
Gle g ga eu:«s LS sdalide cauS A | SelectSimilar A_x:a)i 90 Sl ) SIS g™

R e AT Gl 4g and

Repeat SELECTSIMILAR
Recent Input

Dirnension Style
Precision
Remowve Style Overrides

Annotative Object Scale
Clipboard
Isolate

Erase

Move

Copy Selection
Scale

Rotate

Draw Crder

Group

Add Selected

Select Similar

Deselect L\}f

Subobject Selection Filter

S oaldinl ol AT £ gaia g 43 4l g gaia e 3laa) ()0 2l 58 (e 28 Add Selected 4 X )
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5 IS ) ey qu RS0 s o S QA | Gl amy g a0y ) pdla 1) oo samga R) Hxk
S0 48 29 oa (el (Sa S Canal (2550 SISy cu R Gl 50 0ase G b 25 e Gl K5

«Cawl 2l J\Jﬂbﬁ J\.ﬁ;\ BN \J LSl Sy

..................................

Stretch

_____________________

Origin Point

Hatch Angle

____________

__________

Hatch 5cale

__________________________________________

__________________________________________

A a1 ) sl 4l 68 e iy S ol il b Stretch

iy i 5l () Lie 5 e O gie 49 ) adali (S il 53 e s R (5) QA b Origin Point
SR Do 5ai a8 Cul (ped (5 25 a5 G abati I L sila (5 S L U (oS
A1 Gap adali by caiiine dday) ) ab 4 Canst ) sla

A e ST, ) sdl 4505 :Hatch Angle

SIS e JUES ) sl ibie tHatch Scale

4G (S Y same 4S S ol (5l 83 e guim s 31U S ey i Lk Cilagus i iy ook
DRER) 3 158 i o) 48 salal (sl (S (5 S il 55 e )0 S ek S s x5 e
AU S jie ) aga aaly i) Laia s SOl 4 ol (sl i€ oaliind G o3ld ) i Lah

s )58 e 1 JSia (gl Scale Dl L uad 4na) o ISt b 81 ia ja 35535 (ubite JSia
5wS l1) Tp Cobe by 5 aaa jL8 glajaa | Ctrl+3 2,08 53 sie 4o 2aly adhall ) ey ¢ 4iS

sl Ollai Tool Palettes ab b (s) o jaiy By ) i)
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Imperial samples

L
H]
I_,-:_:‘.:, Door - Imperial
—= Window - Imperial
Aluminum Window
=i (Elevation) - Imperial

Fluorescent (Recessed) -
=~ Imperial

@5 Stud - Imperial
E__;/ Toilet - Imperial
ﬂ/ Trees - Imperial

“E_",i Vehicles - Imperial

D’/ Door Elevation - Imperial

Metric samples
I_,-f_",r/ Door - Metric

—= Window - Metric

Aluminum Window
<s (Elevation) - Metric

] Tool Palettes - All Palettes

_”” Tables [Hatche...lStructu...l Civil [ElectricaI]Mecha... lArchite...[Annota...](onstr... ll‘\a‘lodeli...l

SO, i oaleind 358 sla JIS 3 Ll ) il 65 e 5 il a2 02l (Jle Sl SO ) il 6 yay cl o
AL a1 Gaile <SG ) ealdind aad ) JB 6, wiS a4 das e B ol Gy e

A€ clasl ) of Architecture ik s
5258 QA Wil (555 G S SIS L)) Hlai ) ge K3 AS 2l e IS gl 4 Ll (0l )l 80 s

A S ealdiul Metric samples Gise Sl Laia 48 Gl ol 31 2 50 oy (nl )2 4S (5 455G

ol ok IS (5 e 5 i) (s 5o 3l 3G ) Caed
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: [ x
E mperial samples E-_uwll o
= B

. ~ Uoor mperial
B
5
gl —= Window - Imperial
g . _

9 Aluminum Window
= 24 (Elevation) - Imperial

: : .
Fluores i
. i : 3

G #/ Trees - Imperial
o y
= e Vehicles - Imperial
= o
o

), Door Elevation - Imperial

Metric sarmples

H)_'Lﬂ

l,f_‘_‘;/ Door - Metric

'—d Window - Metric

lables | Hatche..

Aluminum Window
=4 (Elevation) - Metric

Tool Palettes - 4All Palettes

—A|[|

:POIyIine P L_UJg g&i&\)cauﬁ“\ 5 g

12510 o) bk gl g A4S 0 gd a0l (ila () (55 (2 o K Polyline Al ) axy

oo SRR RS EE PR m
4% \n. ____________ e een |
i .
{l ----------- e -
e e -

1 el il 55 e e se 08 Laala 5 IS (2 30 W qu R il L Stretch or Stretch Vertex

YRR KDY
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gk

| Ortho: 5.5685 < 90°

Slad Sl il 5 e 2 ) i) 503 S quli 1 (Copy)C e Guse (RS ks p8a 50 R

Al 48l (oS fpdia & g ge

At ) amy 4SO g (Cpl A i€ Calal o8 il 53 e 4 Rl ) s2l&ind L Add Vertex
k"_ngw\)JA}ﬂbd\d&bﬁjd]&ﬂélﬁ(%ﬁﬁdﬂ&s)adﬁJ.E.'\JJ}A&T\..);&})\Ju,uja6&}CA}A
A A ol iy seadatn ja s anS Al | Add Vertex 4w R

[ T 8.3869 ...... 2.6535 Stretchlurertex
= || AddVerex |

2.6535 Remove Vertex
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A€ SL 1 plaiayse 0 8 il 58 e 4y 8 () 3 Remove Vertex

dgd e Caely 5 asd e ghled JSE idatie (s (S 5o s 4y, K 4l - Convert to ArcArc
S s S 4p ) bad a8

Stretch
Add Vertex

! Comyert to Arc
.- i)\

4 Line J) ealiind b 4S IS5 Lidaiis cy S laa (5551 use s sy S Convert to Line

S s Line 40 ol 90 ) 5 (e 2w 23 S Jaasi Arc

OIS L S Jad )y Express tools 4 R S Wis AUtOCAD Ll 38 a 5 Guai a8 @ age 4555
1 Ll il 55 on 4S 3 9 a adlial I 81 a5l 40 38 A reasie LISl (5 S 4k R 0l 2 S

AES e DS IS sl ) ) ) 4d ged din Le 4S 20S ol Cped 4 Riibon b L) w) Jlg 0

Type a keyword or phrase
Modify | Window  Help | Express  Parametric

ate  View Manage Output Plug-ins  Online

Q\‘\)@ £5a [ List Properties ABg  ABC ER Convertto Mtext I Align Space VA‘ = A@ A Reset Text % [y Attach Xdata
& [is— / 4
%> Import Attributes w22 Auto Number 3 Synchronize Viewperts 2, Import Style [ty List Xdata
Explode Replace Arc Modify _ = Stretch Multiple = Break-line Super | Annotation _ Comman d URL
Attributes Block ‘&% Export Attributes | Aligned  Text ~ (A) Enclose in Object 2 Merge Layout Symbol Hatch | Attachment”™ & ExportStyle | Aliases [ Options
Blocks ~ Ted ~ Modify ~ Layout = | Draw | Dimension ‘ Tools ~ Web
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A€ sl Jae y K Giulas sl 2 58 e L1 0l O 2 Breakline Symbol

Online Wault  SketchBook Designer

v A

Break-line f5uper |  Annotation

ewports

Dimension

Express Tools
hﬁ: Reset Text
¢|-£{ Import Style

Attachment 1% Export Style

AT 3 g sala Giulad K5uSh dlad b AS e giaga (59 )y adadi g3 ¢ )l cpl QAT ) amy
A Ly a3 0 ) 50 JSG A4S 1S e o liie | i€ A ) (SuSls JSE (558 18 Jae (o 5 S

k3

A (e a )i SIS

o & sasa 3 585 (Ssd dai |y g allis Joshad 48 0 S saaliie arw i 3 amy K1 age 4350
rai€ andaii | Ll 3 <l sl ) ealind Ul Sl Gl QLA ) ey 3l ¢ 2l

i1 S Glie ol ol QA e Al il S S L 58 (Kausa dlai s jlail S Siize

Aoy i g€ o i)y At s ge e il platesad jalls alay jo gl i) 5 auS

D E @sbie ) o ladil lae calilh Sa S L 5 & alia kashaa sk S): Extension

AES )5 1 s Jsb G 525 1) STl 5 23S QS
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e D5 O 31 e (S i e i€ osliid 5508 Sl sl S L 5 pSe

A1,y Pat <y b1y Notepad o Hsile (ibs 5 a il Hsdla G 258 048 3,50 (a8

Al 1 253 4Ble 350 sl (Sal 2l g e )l Gl ) i

Online Vault

- [

Break-lindlfSuper
Symbol j|Hatch

ze Viewports
out

t -

Dirate

SketchBook Designer

B
Annotation
Attachment
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Express Tools

-
WA, Reset Text
S Import Style

.._ﬁ Export Style

o~

-

Standard

aile A€ saldind eila 3 S L 5 A8 gl o 5B e o 1 <SSO S b Tl Sl )

Db ohlad )y e et U aiS QIS Super Hatch L)) 5 <SS @dlu i o

Super Hatch...

1) el

P

SuperHatch

=)

Pattem T'_.lf'p%

[ Image...

Black:

|
| Xeef Attach..
[

Wipeout...

| Select existing <

Curve emor tolerance:

|3.84649328

[ Cancel ] [

Help |
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Sl Olbad e iy B s

-

SuperHatch - Insert b Iéw

L

Block
Block... [ARIYANI BLOCK |
File... | |
Oiptions
Specify Paremeters on Screen
Insertion Point Scale Rotation

| ox | | Cameal | | Hep |

A

Lisdsns Bl (paea 534S SOL QAT () Block 4«8 ) 4S 2500 0 9a 5 48 500 5y ol
Alaah 1) O D8 48 5 & s 51 SO Sa 2 S 73 le Fille 4a8a ) 5258 (0 saléiule asidla

25 s o yady (U S SQIS OK 55, (358 (sleiny O oS Al s 0 SO QA Hlamy | sa
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;qgﬁmw.a\Jﬁ)eu%:qus}\)ﬂtjgg%@@)gguﬁ\j\g,q

4&

Specify an option B

.J:\.'a_},\\J‘)ﬁ.'g\oJ\_jJJWJJ)ﬁod\dﬂw%L&d&i@ﬁdﬁﬁdﬂﬁmdmgjonJY\a

:%&SDMMAAQ\}SGA\JA.J&JL«Q\J}&Q

-

OO0 &
O OO«
QOO

o O30 Ll dia 4 23l e S8 50 )8 sla ) ) Ses 51 : Move Copy Rotate ) !

g s 550 ke 501 (S (s Clilee 2l 65 e Lad my cCand sadisala ) ) 30l

a2 alad) g yidg sad A

Insert  Annctate View  Manage  Output

B Convert to Mtext
A E‘: Move/Copy/Rotate
r23 Auto Mumber
T @ Enclose in Object

Text ~ Modify ~

Stretch Multiple

Oblei Base Point alay U s a1 )yl 500 )S QAG) 5 354 ¢ guia ga il ¢ )l Gl QAT 1 2ag
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Ddse

Unao

gl oz A 1) Gl A ) as R o) 55, SIS L eXit

S s | ¢ sase 4t R 0l b :Move

23 oladl 215 e | (S lilee 4% 8 04l L :Copy

80 e aladl | i b )5 Gllee Rotate

S Sa Sk 58,5 1) g s se 3l 55 o :Scale

A€ | s sl b g G el 40 L aas | an 4kl Base
A e R il s cn AT :Undo

) s 4w e g e il 8 e Ladi )l o) Vel Lo Flatten objects.) s

1 L Gled 2l (gamy 4 ) (lad Ha 534S 2l 4381 da 55 had ¢ i€ i (sam 53 e painsa
L O daghas (5 5248 adoaly (e 4o () 0 55 S Uiy Jls s Jlle sl S (e i samy 50
Top sl O 15 (D yoa col R 5 a2 a8 K ) 3 50 7 (gl ) )2 4S 350 005 pans i (5 5h
STrim Jie (el LediaS Gla ) (s (028 o8 L a4l ¢ i€ e ) IStia i€ o8
Level <o sadasha (e 2 cai Jae Wl ) ) 1S (o Jlee) Jle pnse 55, 1, Extend b

uﬁ\cﬁ‘)g\}e.\S\.J.t:\‘_JAa\Ju‘L;\}Uk_ﬁ;\‘)w&jm;igé\sayémw\cdﬁu:\.i
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J\ salaic) Ja ol U.-.‘S}\ 3 (..\.1\..0.1 ‘;ula L;L%J\)ﬁ\ e‘)})ed‘)s \A{.g AutoCAD - da ol ) 93 (e Jia

a0l A L s s a8k e Flatten objects ose

Annotate  View

tto Miext Align Spi
E‘: Move/Copy/Rotate ] Align 5p

lumber l__é Synchrot
Ei Stretch Multiple

zin Object E Merge L:

Layt
H] %
— ByLayer

H

:Flatten objects ) salsiu

Select objects elay U anS lamil | il Gl (s 5 ¢ 2080 43810 (5% 4s & gua 0 S 2L iyl

A Al Hhia ) Cle pasely 5 g a0 Canly (0 4S 25 e il

ags Ol ) Gl Bani ) A as S QA ) Qe g ge S Sl A

[~
A

Remove hidden lines? <Yes=: Iil

258 Sby Ay dashad aa) & et 4S a e J) g Led ) Al 0l

Sl 85 asd e cids idhdaghd (i€ i (Yes)Y <be sl gl s 53 Al

Rl (e 02 Al (Samy 3 & saiage ) (S et Sy o shad oS i) (NO)N

Anba SO am ol Gl 5230 e sy syl 0aS) hshd )l ol Cidgs o
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—

D

‘aﬁ

D948 358 e ealiid LS (55 e G555 s)x L0 o) SV CATC Aligned Text L1

A a5 1 S b)) o) ) ealiid ) U8 A5 ad (San o sane cilla

Mesh  Render  Parametric  Insert  Annotate  View Manage

roperties Ex Convert to Miext
(=] A E‘: Move/Copy/Rot
rt Attributes - 23 Auto Mumber
odify _ E2 Stretch Multiple
t Attributes k. Text @ Enclose in Object
| Text - | Modify -

90050 e (e se sl U8 JUS 50 B i SIS )l Gl 550 e S e i 1) QlaS A8 ) Gy

AT |y i3 e S ealig () o3 Liie L ¢ Select an Arc or an ArcAlignedText: 1gd oula

1358 3 ) eak 15 anS

ArcAlignedText Workshop - Create Iél
File Edit Format Help

BE UAEC AR FX ED msee

[Standard - ] [ T Adal ]

Tewt ‘Www.drch-two.Com |

Properties:

Test height;  0.425 Dffzet from arc: 0.325
Width factor: 1.0 Offset from left: 0.0

Char spacing: 0.095 Offzet from nght: | 0.0
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?JJSGA‘)SJ\‘)L)J}?@ALSS\AJ\SMA(‘.\\AJ\\Jummbﬁga‘){)auw‘)dc‘)mguﬂ)d

Ot 9 Caand (g i age 5 Ol sl A€ a5 ) a5 Hhai 0 ) se (e aliany K ol S sl o Text

AL e 0 g

S Gpaad ) (e gl ) Text height

NS e paat ) GlalS (e L 5 Uiy :Width factor

A e IS 4 a0 alals :Char spacing

WS o JUES ) laS 44 Can (e abiald - Offset from arc

NS e aalaii ) GleS i i (sl 4y i (ie 4lald :Offset from left
RS e aadat ) leS Cal ) Cren (slglil 4y i (i alald : Offset from right
Al caalia |y IS 4t U ai€ SO OK 55 Slapdatt )

\N P\fCh-tow

Co

C

Sa12) 1S (SISl a (fie (55 S Gl g |y s dlagl (e el s e el )y 81 : age 435

\?\sﬂ

\)QLA&M‘\.L}}J)A&\AJL&JJDHU..}\ JJ}J)ﬁuQLAJt)m}AuLAA QMDHL—I(‘—&J&S
REREEN)

g s ga Olea Cliadidia o jahy (SOL ) 2) XSl ja o pmge 8 (55 SAS JLga b age 4550
A el Gl (g9 1 (ALl g 2l 55 e aS 250 e Ll

sta ) )l ealiinl LaS ) ol (e il 68 e 30l ol OV edlsind b :Exploded Text L1
Jue! e 551 L 0l 48 (Ple) S jadia 5SS a8 ) S Aol Mitext s Text
25l e dias Polyline osis ) oia IS S 43 Jiad (e o 2K (s
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Render  Parametric  Insert  Annotate  View Manage

B Ex' Cogyert to Mtext
H AIEI o E;: MDUEfCDFI}[fF
ES — FRuto Mumber

Arc Madify | E§ Stretch Multig
== | Aligned| Text ~[(A) Enclosein Object

Modify ~

AO Rotate

) i) G 5 23S SIS (e (55 Ol 3l ) AT ) Gy

Auto cad Auto cac

v : :

22 i g pa (S sS 5 (S5 il 5 e 1 0l il sliid L :Change text case L) !
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A€ aalait ) ) Dimenssion b s Mtext 2

,&-E-E AE LER Convert to Mtext

- w23 Auto Mumber
Arc | Modify £ Stretch Multiple
Aligned| Text | (A) Enclose in Object

E‘: Move/Copy/Rotate

| Modify -

| Aa crorsecog]
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m}&u\_}u.ié%}SDHb%JS;&JE)LJJJ}A@J\L\L;Q}WL;}JJ\}\ug\&.:\;;;\)\lu

S SIS OK 50 5w aladl ) lalati o jady Gl 0 (5

Auto cad

-
M@SE - change text case R

() Sentence case.

[TV UPPERCASE

Select ob :

() Title
() tOGGLE cASE.

[ ok [ Camesl | [ Hep

5l i 4 galae) (3 K adlial () uie b ) W Automatic Text Numbering L) !
G Ala 1 ML 5 2 b g g dlae ) (g0 2l 5 e 100 0l b 25 498 Al an e iy

S

Dy

Render  Parametric  Insert  Annotate View  Manage G

B Ex Convert to Miext
A=¢ [a]] I3} Move/Copy/Rotat:
Ites - 23 Auto Numl::l
Arc Modify | E> Stretch Multiple

tes | Aligned  Text [A) Enclose in Object

| Teut = | Ml:ll:lif_‘,f -

DBEL G- QLB R(EEDSE

1 S0 a2 Jla (sl ¢ 2l oa S alagl | gaae (e dia ol oy e Ladi Sl 30l ) ) ealéiad (g
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e Lxn Minimal Bolt Diameter Ay 4466 mm ’
Bolt Material
Maximal Axial Force F, 790N C [ |user material
Maximal Tangent Force F; ON C Yield Strength S‘r’ 639 MPa b
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